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1 Retina: MicroERGs and Spikes 

1.1 Aim of Experiment 

 

The retina is a peripheral, easily accessible part of the central nervous system. Stimulation  
with light pulses results in a complex signaling by neurons within the layers of the retina.  
The retinal ganglion cells transmit retinal information to higher visual centers in the brain  
via their axons that form the optic nerve. Retinal function can be affected by acute injuries, 
intoxications, or retinal diseases, either inherited or acquired, resulting in visual impairment  
or even blindness. 

The electroretinogram (ERG) is an extracellular field potential generated by the cells in  
the retina. So-called microERGs can be recorded with the MEA-System from retina explants,  
for example, from rat or chicken. For the recording of light-evoked activity, a retinal segment  
with the pigment epithelium, is placed ganglion cell site down on an MEA. Local ERGs  
(microERGs) with the typical components and ganglion cell spikes can be recorded with 
appropriate filter settings with the MEA-System. The prominent components of the microERG  
can be pharmacologically identified. 

This in vitro retina sensor can be used for assessing effects of pharmacological compounds  
and putative therapeutics, drug side effects, and consequences of degeneration-related  
processes on retinal signalling. 

(Reference: A. Stett, U. Egert, E. Guenther, F. Hofmann, T. Meyer, W. Nisch, H. Haemmerle; 
Biological application of microelectrode arrays in drug discovery and basic research.  
Analytical and Bioanalytical Chemistry, 2003. 377, 486-495.) 
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Task 

Extract the spiking activity superimposed on microERG field potentials by an offline 
analysis; graph, print and save the results. 

Note: In this chapter, you will set up an offline analysis rack (for the demo data file) step by step. 
You can set up a virtual rack for online recordings and analysis likewise, simply add the MC_Card 
as the data source to the rack instead of the Replayer. 

Field potential electroretinogram 

The example data shows a typical microERG recording. The demo data  was kindly provided  
by the NMI Reutlingen, Germany. 

 Rack file: Retina_MicroERG_Demo.rck  

 Data file: Retina_ERG.mcd  

Spiking activity 

Spiking activity is visible in the ERG traces as well and can be easily extracted from the underlying 
field potential with the Spike Sorter in Slope mode.  

Alternatively, the field potentials can be removed by a digital 300 Hz High Pass filter,  
and spikes can be detected by setting a threshold. This sample rack demonstrates both methods, 
and the spike sorting feature. 

The raster plot highlights the regular spike pattern. 

The demo data used in this part of the tutorial was kindly provided by the NMI Reutlingen, 
Germany. 

 Rack file: Retina_Spikes_Demo.rck  

 Data file: Retina.mcd  

Please see also the MEA Application Notes for more information on the preparation techniques 
and experiments. 

You will learn in this chapter ... 

 How to define basic functions in your rack configuration: 

 Remove field potentials for extracting spike signals by digital filtering (Filter). 

 Detect spikes by defining the spike detection level (Spike Sorter, Threshold mode). 

 Detect spikes with an underlying field potential based on the waveform (Slope mode). 

 How to customize the rack: 

 Modify the display layout (all display types). 
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1.2 Preparations 

We recommend that you take some time for rebuilding the virtual rack for this application step  
by step in this tutorial, but if you prefer having a look at the completed rack or if you get stuck 
during the tutorial, you can also open the rack file Retina_Spikes_Demo.rck. Click Open on  
the File menu to open the rack file. 

1. Copy the complete MC_Rack Tutorial folder from the installation volume into the MC_Rack 
program directory with the following path "c:\Program Files\Multi Channel Systems\MC_Rack\" 

2.  Start MC_Rack or click New on the File menu to generate a new virtual rack file configuration. 

3. Click  on the toolbar to add a Replayer to your virtual rack. 

4. In the tree view pane of the virtual rack, select the Replayer and click the Replay File tab.  
Click the Browse button and browse to the Offline subfolder of the Tutorial folder,  
and load the data file Retina.mcd into the Replayer. 

 

1.3 Monitoring Field Potentials and Spikes 

With the MEA-System, you can record slow signals like field potentials and fast signals like spikes 
in parallel, depending on the amplifier settings. 

1. Click  on the toolbar to add a Data Display to the virtual rack. 

2. Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the replaying of the data. 
Each virtual instrument in the rack configuration starts to process the channels and data streams 
that were assigned to it. For example, data is graphed in the displays, and so on. You can adjust 
the replaying speed on the Replayer tabbed page of the Replayer. 
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3. Zoom the axes to see the signals clearly. You see large sum potentials on all electrodes.  
Spikes are not detectable on all channels, but you can see spikes on electrode 25. 
 

 
  

4. Zoom into the data recorded from electrode 25 by double-clicking display 25. 
 

 
 
You see spike signals superimposed on the large field potential. It is impossible to detect all the 
spikes by defining a threshold. To circumvent this problem, you can use a filter that removes slow 
signals, that is, field potentials. In the current version of MC_Rack, a second order Butterworth 
filter is available. Please be aware that all filters deform signals. It is always a compromise 
between good filtering and low signal deformation. 
Another option would be to detect spikes by their waveform, that is, use the Slope mode  
of the Spike Sorter. We will look into this alternative later. 

5. Click the Delete Instrument  button to remove the Data Display again to save computer 
performance. 
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1.4 Removing Field Potentials with a Digital Filter 

1. On the toolbar, click  to add a Filter to the virtual rack. 

2. In the tree view pane of the virtual rack, select the Filter 1. Click the Channels tab and select  
the channel of interest, number 25 in this case. Digital filtering is quite demanding regarding  
the computer performance and should be limited to the channels of interest. 
 

 

3. Click the Filter tab. 

4. Select High Pass. 
You can choose between two filter types: Low Pass and High Pass. As the name suggests,  
a low pass filter passes the lower frequency components but attenuates the higher frequency 
components of signals. To remove slow components (with a low frequency) and to let pass high 
frequency signals, you need a high pass filter. 

5. Type in 300 Hz as the Cutoff Frequency. The high-pass filter now cuts off frequencies below  
the specified 300 Hz. For spike activity, you usually use a Cutoff Frequency of 200 Hz or above, 
depending on the frequency of the noise and the slope/waveform of the spikes. The cutoff 
frequency of the filter must be compatible with the frequencies present in the signal of interest. 
 

 

6. Add a Data Display to your rack. Load the 8x8 MEA Channel Map. On the Data tabbed page, 
select the Electrode Raw Data and the Filtered Data streams. 
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7. Click Start  to start the Replayer, and zoom the traces. The filtered data traces are displayed 
superimposed (blue) on the unfiltered data (red). You see that the field potentials have been 
removed. 
 

 
  

8. If you zoom into single spikes, you can also observe slight differences in the waveforms that are 
always obtained when filtering data. The negative component is slightly smaller after filtering,  
for example. This does not matter for analyzing timing and patterns, like extracting the spike rate, 
but you should keep this in mind when analyzing and comparing spike waveforms, for example, 
when you sort spikes. 
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1.5 Detecting Spikes (Threshold Mode) 

The Spike Sorter detects spikes, and features an online (or offline) spike sorting into up to  
three units. For example, you can use the Spike Sorter for sorting units from ON and OFF cells. 
The spike cutouts form a new data stream that can be analyzed further (or recorded to the data 
file). The unit information is saved in the data file and can be used for the analysis with external 
programs. The Spike Sorter has a special display where you can either set the spike detection 
level, or sort spikes in an interactive kind of way. 

There are two modes for detecting spikes with MC_Rack. One method uses a threshold,  
the other recognizes the amplitude and slope of a waveform. Both methods regard either  
the rise or the fall of a signal, depending on the settings. 

The Threshold method is especially useful if the overall baseline is stable, and spikes appear 
approximately on the same height. You can set the spike detection level for each channel 
separately (manually or automatically), or you can choose the same level for all channels.  
If local field potentials are underlying the spikes, or if you have an unstable baseline, spikes  
will be missed, or noise signals may be detected as spikes with the threshold method. In this  
case, the Slope method is more appropriate. 

In this tutorial, we have used a digital high pass Filter to remove field potentials and to prepare 
the data for using the threshold method. We will also demonstrate later how to extract spikes 
using the Slope method from unfiltered data. 

1. On the toolbar, click  to add a Spike Sorter in series with the Filter to the virtual rack.  
If you put the Spike Sorter in parallel to the Filter, it would not be possible to use the filtered 
data stream as an input stream for the Spike Sorter, because virtual instruments can only use the 
output streams of other virtual instruments that are upstream in the tree view as input streams. 
The Spike Sorter display appears (in detection mode). 

2. Select the option Peak Detection in the Spike Sorter display. 

3. Click the Channels tab and assign the Filtered Data stream to the Spike Sorter. 
As the Filtered Data stream includes only channel 25, only this channel will appear in the Spike 
Sorter window. All other window slots appear empty. You may want to customize the display 
layout at this point. 

4. Click the Start button and zoom the display until you can see the signals clearly.  
You see that the baseline is on a similar level for all channels and that the spikes are quite small 
(approximately 10 to 20 μV). 

5. Click the Detection tab. Make sure the Threshold method is selected. You can now set the 
detection threshold. Start with a value of 15 μV, for example. 

6. Type in 15 in the text box. This value does apply now to the selected channel. Under Apply  
to All, click Level to apply this detection level to all channels. You can also use the Automatic 
feature to automatically assign an individual detection level to each channel, which is very 
convenient if you have multiple channels for extracting spikes. The standard deviation of each 
data trace is used to estimate its spike threshold. A time interval of 500 ms is used to calculate  
the standard deviation. You set the factor, by which the standard deviation is multiplied.  
The sign of the factor determines whether the spike detection level is positive or negative.  
You generally will use a negative factor. A value between -1 and -4 is appropriate for most 
applications. For example, enter a standard deviation of 2, and click Refresh to calculate the 
standard deviation and apply the result. Spikes appear in a different color on the display.  
The detection level of 8.5 determined for this channel by the Automatic feature is visible  
as a horizontal straight line. 
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7. The level may still be a bit too near the noise level. You can then fine tune the detection level  
by dragging the horizontal line of each channel in the Spike Sorter display with your mouse,  
or use a higher standard deviation. If you have multiple channels, you can use the option  
Tune all levels to modify the level of all channels at once. 
 

 
 

 

8. You can then switch to the spike overlay mode of the display by clicking the  button  

on the display toolbar, and switch back again to the other mode with the  button.  
Depending on the application, you could then use the spike sorting feature for discriminating 
signals from ON and OFF ganglion cells, for example. 
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1.6 Customizing Displays 

As it may not be useful to extract spikes from all channels, you can set up your custom layout  
for the Spike Sorter (this is true for all displays), to save space on the screen. You may be 
interested only in one or two channels. (Remember: You can save the raw data of all channels  
in the Recorder.) 

1. In the tree view pane of the virtual rack, select the Spike Sorter (or the display that you want  
to customize) and click the Layout tab. 
The default layout is loaded. In the Rows and Columns boxes, you can now modify the layout. 

2. Type or select the number of Rows, for example 1, and the number of Columns, for example 1. 
On the right, a linear layout with two channels appears. 

3. Assign the channel numbers to the empty slots, for example channel 25: Click to select the empty 
slot in the white layout pane, then pick 25 from the Channel list. The active slot is highlighted by 
a dotted line. The Spike Sorter Display is updated accordingly. 
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1.7 Detecting Spikes (Slope Mode) 

In Slope mode, spike detection is performed on the waveform rather than the spike level. 
Therefore, it is possible to extract spikes even if field potentials are underlying the spikes, as in 
this example. Therefore, you can extract the spikes from the unfiltered data with this method. 

1. In the tree view pane of the virtual rack, select the Spike Sorter, and click the Channels tab. 

2. Click the Electrode Raw Data stream, and then select channel 25. 
 

 

3. Click the Detection tab, and select the Slope method. 
 

 

4. You now have to play around with the amplitude (dV), and the minimum and maximum  
slope until you achieve satisfying results. For more information on the Slope mode, please see 
"MC_Rack Features", "Spike Sorter", "Detecting Spikes by Waveform". For example, you know 
that the minimum amplitude should be around 10 mV for this data, so you can try 10 for dV,  
and then play around a bit with the parameters. 
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2 Saving the Rack and Saving Data 

2.1 Saving a Rack 

Save the virtual rack configuration if you like to keep it for future use, for example  
for an offline analysis of identical data recorded in another experiment. 

1. On the File menu, click Save As. 

2. The Save As dialog box opens. 

3. Browse your folders and select a path. 

4. Enter a file name and confirm by clicking Save. 

The file extension for the rack files is .rck. 

2.2 Selecting Data Streams for Recording 

MC_Rack's philosophy is to strictly separate the actions of all virtual instruments in a rack.  
That means, that you could record to hard disk completely different data streams and channels 
than you monitor on the screen. This has the advantage that you can store exactly the channels 
you are interested in, but it also has the slight disadvantage that all virtual instruments have to be 
set up separately. Please be especially careful when configuring the Recorder, to avoid data loss. 

When you have finished setting up the rack, you can select the data streams and channels that 
you want to save to the data file specified in the Recorder. 

Selecting data streams and channels for recording 

The fate of each single channel is independent from other channels. You can pick exactly the 
channels you like to save from all generated data streams. For example, you can decide to save 
only one channel of raw data, but the peak-to-peak amplitude results of all, or of a specific 
selection of channels. 

1. Select the Recorder in the virtual rack tree view pane and then click the Channels tabbed page. 
On the white pane on the left of the Channels page, you see the data streams that are available 
with your rack configuration. When replaying data, you are generally more interested in the 
parameter data streams, but you can rerecord the raw data as well, in case that you want to save 
the raw data and the extracted parameters to the same data file. 
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2. Click the data stream that you are interested in, generally the parameter streams. 
The available electrode channels appear in a button array on the right side. Parameter stream 1  
is generated by the first analyzer in the rack (here: for extracting the peak-peak amplitude), 
parameter 2 is generated by the second analyzer (here: for extracting the slope). 
 

 

3. You can now either select all channels by clicking the check box next to the data stream name,  
or you can pick single channels by clicking the corresponding buttons. For more information, 
please see "Channel Selection" in the MC_Rack Features section. Only data from the selected 
channels will be saved to the hard disk. 

2.3 Creating a Data File 

If you want to write the parameters that you will extract in an offline analysis to the hard disk, 
you have to specify the file name and path in the Recorder. (It is not possible to change or 
overwrite existing data files in MC_Rack, for example, adding the spike rate to an existing data 
file, but you can record the raw data together with the spike rate stream to the same file.) 

Choosing the file name and path 

1. Click the Recorder tab. 

2. Browse your folders and select a path. 

3. Type a file name into the text box. 

4. Confirm by clicking Save. 

The data file is then generated automatically when you start MC_Rack in recording mode.  
The file extension for the data files is *.mcd. 
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File size limit 

When the maximum file size specified by the user has been reached, a new file is generated 
automatically. The file name is extended by four digits, counting up, for example  
LTP-Parameters0001.mcd, LTP-Parameters0002.mcd, and so on. 

If you rather prefer that the recording is completely stopped when a file has reached the 
maximum size, please select the option Auto Stop. 

For information on more options, please see "Generating Data Files" in the MC_Rack Features 
section. 

Selecting data streams and channels 

As has been said before, the fate of each single channel is independent from other channels. 
You can pick exactly the channels you like to save from all generated data streams. For example, 
you can decide to save only one channel of raw data, but the peak-to-peak amplitude results 
of all, or of a specific selection of channels. 

 Click the Channels tab. 

As long as the rack is still empty, you see an empty box. There are no channels available at this 
point, because you have not chosen a data source yet (MC_Card for online data acquisition or 
Replayer for replaying data files). Without a data source, there are no data streams available  
for recording. Remember later, when you have completed the rack, to assign the channels that 
you like to save to the data file to the Recorder. 

After you added a data source, you will see the electrode raw data streams provided by the data 
source (for example, electrode raw data, analog data, and digital data from the MC_Card, or the 
data streams included in the data file loaded into the Replayer). If the rack file contains virtual 
instruments that generate data streams such as Spikes from a Spike Sorter or Parameter streams 
from an Analyzer, these data streams will be available for recording as well. 

2.4 Starting Data Acquisition and Recording 

Now that you have completed the virtual rack, you are ready to start the rack. 

 Click Start  (either on the Measurement menu, the toolbar, or the Rack tabbed page)  
to start the data acquisition. Each virtual instrument in your rack starts to process the channels 
and data streams that were assigned to it. 

 Click first Record  and then Start  to write data to the hard disk. The data from the 
electrodes selected in the Recorder is saved to the file and location specified in the Recorder. 

 

 Click Stop  to stop the data acquisition. 

 

Warning: Only data of the channels and data streams that were selected in the Recorder are 
saved in your data file when you start a recording. Data is only saved to the hard disk when the 
red Record button is pressed in. Make always sure that you have selected all channels of interest, 
and that the Record button is active before starting an experiment to avoid data loss. 

 


